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OVERVIEW

Overview

The PeopleSoft Financials Workbooks in the KUMC Data Warehouse provide access to PeopleSoft financial data through a web
interface. The data available consists of payroll, purchasing, travel and IDB transactions similar to line items reported on the
AM90/91 monthly report. Revenue is reported for revenue SpeedTypes. Both Summary and Detail reports are available. Data is
refreshed daily.

The Summary report contains a table and a graph of data. The table portion displays a separate line for each budget category. The
budget categories are 1005, Salary and Wages; 1745, Fringes, 2000, OOE; and 2005, Telephone and Networking. For revenue
SpeedTypes, related revenue budget categories are displayed, each on a separate line. Budget/Revenue, Expenditure,
Encumbrance and Balance values are displayed for each line.

The graph of the summary data is a column chart comparing the values in Budget/Revenue, Expenditure, Encumbrance and Balance
in each budget category to each other.

The Detail report is a table of transactions similar to the detail page of the AM90/91, with the transactions in date order. Each line
includes the Account Code, ID number, Source, Vendor, Description and related transaction amount. See the next page for
information on the data displayed for each type of transaction.

Users are able to view or print information related to a Department or one or more SpeedTypes. Viewed data can also be exported
to Excel for further analysis.
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OVERVIEW

Overview (continued)

Description of transaction lines on detail report

Transaction Type ID

Source

Vendor

Descriptor

Value

Salary

Journal ID

Pay

Payroll Processing

Pay period number and start date

Expenditure

Fringes

Journal ID

Pay

Payroll Processing

Pay period number and start date

Expenditure

Retroactive Funding

Adjustment

Journal ID

RFA

RFA — RetroActive Fndg
Adj

Payroll Adjustments

Expenditure

Budget Adjustment

BAF number

Blank

Blank

Journal Entry or description entered
by budget office staff

Budget/Revenue

Purchase Order

PO Number

PO

Vendor name

Distribution

Encumbrance

Voucher

Voucher number

AP

Vendor name

Line description from PO

Expenditure

BPC

BPC number

BPC

Business Procurement
Card — KC

User name from BPC entry

Expenditure

IDB

Various - see below

Various

Various

Various

Expenditure

Telephone/Network

TELECOM

MYS
MYW

MYSOFT-TMIS-location
Billing

Location TeleCom Expense

Expenditure

Travel

Travel number

AP

Traveler

Blank

Expenditure

Airline Ticket Purchase

Voucher number

AP

UMB Bank Visa

AIRFARE traveler name

Expenditure

Revenue SpeedTypes Only:

Beginning Balance

Journal ID

B3 Beginning Balance

FY #### beginning balance

Budget/Revenue

Revenue

Journal ID

Accounts Receivable

AR Payment Transaction

Budget/Revenue

Deposit

Journal ID

Online Journal Entry

Line description from journal

Budget/Revenue

Abbreviations used in IDB IDs

Source

ID

Billing Department

Source

ID

Billing Department

BIO

BIOTECH

Biochemistry

LAR

LAR

Lab Animal Resources

FMO

FACMGMT

Facility Management

MYS

TELECOM

Telecommunications KC

IDB

IDB

Interdepartmental Billing

MYW

TELECOM

Telecommunications Wichita

IRB

INFORESR

Information Resource
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ACCESS THE DATA WAREHOUSE

Navigation

# Step 1 You can enter https://dw.kumc.edu:4444/discoverer/viewer

directly in the address bar in Internet Explorer.

Sraertes @ |- % B DRSS

login. jsprsiteZpstoretoken=v1.4~CSD1454E~97CBFSE5A1 AAZ4491 5741 SEI3B9403B0E3BCHASTF 170634

KUMC data Bmms

Owarehouse EEEE

Enter your usemame and passwoard to sign in

User Name“

F'asswcurd|

Unauthorized use of this site is prohibited and may subject you to civil and criminal prosecution.

1. Double-click PS-FIN Data Warehouse icon on your
desktop.

2. Enter your Novell user name in the User Name field.

3. Enter your Novell password in the Password field.

4. Click

[ Login ] _
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https://dw.kumc.edu:4444/discoverer/viewer

CONNECT TO ORACLE DISCOVERER

Connect

KUMCdatg Emmm
warehouse 1

Connect Directl

Connect to OracleBl Discoverer
To connect to OracleBl Discoverer, click on a connection name or enter your connection details directly
Choose Connection

Create Connection

[Details|Connection « [Description Jupdate[Delets|
‘bShuwF‘eug\eSuﬁFmanc\a\sta ‘ | y ‘ W

Result List

Fefresh |

Expand All | Collapse All

ZDhiscoverer Workbooks

FocusName

r  Discoverer Workbooks

- 2 PeopleSoftFinancials

Result List

Fefresh

Expand All | Collapse All

ZDiscoverer Warkbooks

FocusName

r  Discoverer Workbooks

T W FPeopleSoftFinancials

Detail

SUmmary

1. Click PeopleSoft Financials Data link.

2. Click E| (expand) next to PeopleSoft Financials
Workbook.

Click desired report type (Detail or Summary).
For Summary report, go to page 7.

For Detail report, go to page 10.

After making your initial choice, you can switch report type
by using the Worksheets menu at the left of the
Parameters page.
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VIEW SUMMARY DATA

Enter Parameters, Summary Report

PeopleSoft Financials Workbook - Summary Report
Last run Monday, April 21, 2008 01:09:46 PM CDT
Parameters Meeded

Cetail Report Select values for the following pararmeters.
Summary Report * |ndicstes required field

* Fiscal Year |2008'

Enter parameters to obtain desired data.

Fiscal Year is required.

Distribution
Code

Example: 00130 . Enter Distribution Code or Department ID or Speedtype.

Department 1D | . =
£ . u]
Example: 65101 . Click| =X

Speedtype |
Example: apps0101, ROMVED 01

&l

Query Progress

@Execming fquery

Estimated Time Linknown

A Query Progress page will display while data is retrieved.
Elapsed Time 00:a0:a1 Query Prog pad e

Cancel | Eefresh |

fo"apse button PeopleSoft Financials

Rerun query Data refreshed 21-APR08 8:00am

Save rParameters
Save as

Revert to saved

Printable page
Expot x Fiscal Year |2008° | &
Sand as email ’

Distribution
riorksneet oplions “
Worksheet options Code ‘ | <7

— P Optional: Once the query results are displayed, click E

Fremyle B3101 (collapse) next to Parameters to view more data on the screen.

Speedtype “appBDQDT | {
Example: appe0T 01, ROWED 1

Select values for the following parameters.
* |ndicates required fiekd

Example: 00130

Dietail Report
Summary Report

Go
*Table
»Tools Layout Format Stoplight Sort Rows and Colurnns

Page Iltems Fiscal Year 2008 v Speedtiype Key | APPEO201
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VIEW SUMMARY DATA

View Summary Data

»Parameters
+Table
»Tools Layout Format Stoplight Sort Rows and Columns

Page Items Fiscal Year Speedtype Key | APpPE0201 v

Fund Code Speedtype Descr | PeopleSoft Admin Suppont v| Dept Desct | FaoplaSoft Admin Supp
Fund Descr | Operating Expenditures v

#Budget Period »Account Type W Budget Category »Budget Category Descr »Budget /Revenue  wExpenditure  »Encumbran
d | | | | | |

2008 E 1005 S & $228,359.00 $77 74874
2008 E 1745 Fringes $72529.63 $23,539.68
2008 E 2000 QDE $6,560.00 $3,344.97

Sum: §307 748.63 Sum: $104633.39

+Graph
»Tools Graph Data

Page ltems Fiscal Year 2009 « Speedtype Key | APPEO201 Deptid euzm v

Fund Code |p5p3 Speedtype Descr ‘ PeopleSoft Admin Suppart | Dept Descr | PeapleSaft M\m Support v

240K
200K
1BOK
120K

HO0K

Page ltems Fiscal Year [2008 v/ Speedtype Key | APPED201 v | Deptid  [B0201 |
Fund Code @l Speedtype Desct | PeopleSoft Admin Support | Dept Descr | PanpleSoft Admin Support v
W Budget Period »Account Type w-Budget Category wBudget Category Descr w-Budget /Revenue  wExpenditure  wEncumbrance  wBalance The table portlon of the SUmmary report dlSplayS a Separate line

o] 1 1 1 | 1 | | |

e E s caw g Rt . for each budget category. Budget/Revel_wue, Expenditure, .
2008 1745 Fringes 7282963 §23,530.68 §49,289.95 Encumbrance and Balance values are dlsplayed for each line.

2008 E 2000 QQE $6,560.00 $3,34497 §0.00 $3.215.03
Sum: §307 748 B3 Sum: $104 B33.39 Sum: $0.00 Sum: $203 11524

1. Use scroll bars to view additional data.

p-Tools Graph Data

Page ltems Fiscal Year Speedtype Key  [APPE0201 '+ Deptid — [goz01 »

Fund Code Speedtype Descr | PeopleSoft Admin Support + | Dept Descr ‘ PeopleSoft Admin Support &

Fund Descr | Qperating Expenditures v

- The bottom portion of the Summary report contains a graph of
the data. Each column of the graph represents a budget
category.

160K

120K

B0k

40K

Budget /Revenue Expenditure Encumbrance Balance

Version 1.1 KUMC Confidential Page 8 of 28
April 2008




VIEW SUMMARY DATA

View Summary Data (continued)

KUMC data mems

Owarehouse EEEN

Preferences Logout Help

|

Connect > Warkhooks > PeopleSoft Financials ¥Workbook - Summary Report
PeopleSoft Financials Workbook - Summary Report
Lazt run Monday, April 21, 2008 01:10:51 PM CDT

Rerun query
rParameters

P Sel\a_m values mrm fallowing parameters.
 Indicates required fisld

Erintable page

Export = Fiscal fear 2008 rd
Sand as email ’
b T 4
Code 3

Warksheet options
Example: 00130

Departrent 1D (
Detail Report Example: 56101
Surntary Report

peedtype 'appBO201" re

Connected to PeopleSoft Financials Data

PeopleSoft Financials
Data refreshed 21-APR-08 §:00am

2. Click as desired.

To ...

Click...

Go to Step...

Query another
SpeedType or
Department

Scroll to parameters
(»] expand if needed)

1onpage?7

View a Detail
Report

Detail Report link in the
Worksheets menu

1 on page 10

Exit the Data
Warehouse

Logout link in the upper
right corner of the page
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VIEW DETAIL DATA

Enter Parameters, Detail Report

PeopleSoft Financials Workbook - Detail Report
Last run Friday, April 11, 2008 12:29:11 PM CDT
Parameters Needed
Detail Report Select values for the following parameters
MM #* |noficates reguired fisld
* Fiscal Year [2008 4 . Enter parameters to obtain desired data.

Example: 2008, 2007

Dismbgtizn | ‘ g Fiscal Year is requirEd.
ode K4

Example: 00130

& Enter Distribution Code or Department ID or Speedtype.

Departrnent 1D

Exampie: 60201, 04030 Optional: enter a date range by entering Begin Date and
Speedtype ‘ J End Date. /

Example: appE0201, RFFO4030

Start Date ‘ {
(Example: 11-APR-2008) Click Gg

End Date | ‘ ¢

(Example: 11-4PR-2008)

el

# Step 1 Note the format for entering dates is dd-MMM-yyyy.

Detail
Query Progress

@ Executing query

Estimated Time O0-00-05 A Query Progress page will display while data is retrieved.
Elapsed Time 00:00:07

Cance] Beftesh

PeopleSoft Financials Workbook - Datall Report
Lt run Menday, April 21, 2008 0115

C.c;lliaﬁée button

PeopleSol Financials
Data refreshed 21.APR 03 8:000m)

vParameters
Selact valugs for tha fellowsng pasametars.

= Figcal Yoor | 2008

Dvstribution
Code

9_«::!_3'_ —— _ Optional: Once the query results are displayed, click IE‘
S e ¢ (collapse) next to Parameters to view more data on the screen.
End Date .
S i

*Table
®Tooks Layout Eormat Slephgh! Soel Rows and Columns

Page lhams SPISSDE | Arpamn » Spwediype D¥SE | Peopleson Admin Suppen | | D (B w
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VIEW DETAIL DATA

View Detail Data

KUMCda’[gI'
~warehouse =

Prsforences Logous Help

Conngct > Workhooks > PeopleSof Financials Workbook - Detail Repont arnisctid b PeopleSalt Financials Data
PeopleSoft Financials Workbook - Detail Report
Last run Wednesday. November 21. 2007 08:42:51 AM CDT
(Actions | PeapleSoft Financials
Rerun qusry Data relveshed 21.HOVOT B:00am
i » Parameters
*Table
»Tooks Layoul Fomal Stophoht Sod FHows and Columns

Bever o saved

Dept  |e0201 » Fund Code pz03 »

1. Use scroll bars to view additional data.
=Fiscal »Budget mAccount =Budget »Budget mAcct mAcct  mDate (2] mSource W = Descriptor
Year Period  Type  Category Cg:&n:y Descr

2000 2003 S&wW 1005 S&W 01-JUL-2007 D0OD430167 KU Budget
Opening Entries
2008 Fringes 1745  Fringes 01-JUL-2007 DOOD433168 1) Budget
Opuening Entries
i - F O0E 2000 OO0E  O1JUL2007 OOO431926 ¥ Budget
Opning Entrins
am O0E 2310 Copier (SJULZNT  OOO01STE16 Century Distrbution
Rt United
Companies,
Inc
DF  11JUL207 @ Dell Distrbution
Supply Marketing
LP.

Page ltems Speedtype SCFE v : Fund Code

Speedtype Descr ‘Description here Dept Descr Description here ~ | Fund Descr

9 Up Down v P Rows 1999 o 3435 ) )
pFiscal »Budget »Account »Budget »Budget »Acct  eAcct »Date »Id P Source The maximum number Of rows Of data that can be dlsplayed at
Year  Period Type  Category Category Descr one t|me is 999

Descr
| | | | |
Serv Chrgs 0530 Cth Charge 08-JUL-2006 ARDD3E7637 AR Accu_u . i . i
Recely If there are fewer than 999 rows to display, this navigation bar
O0E 2210 Pt State  068-JUL-2006 DB DB IDB Bil does I’lOt appear.

O0E 3490 Equip Part 10-JUL2006  FACMGMT  FRO FrO -
K IDH

Sery Chrgs 0530 Oth Charge 12-JUL-2006  ARDD335471 AR Accoul
)
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VIEW DETAIL DATA

View Detail Data (continued)

0 U 999 Rows Diowin

»Fiscal »Budg'U000 Rows Budget wBudget
Year  Periog! 20 ':'WS Category  Category

- v | Descr You can select a different number of rows to navigate by
_ from the drop down list. For example if you choose 999

1
2007 2007 511 Serv Chrgs rows from the list, when you click the |'¥'| button, you will
move down 999 rows of data.

Click [Dowet or (navigate down) to view next 999 rows.

2007 2007 2000 QoE
Page ltems Speedtype Dept Fund Code E

F Bpeedtype Descr [Description here ~| Dept Deser [Description here ~ | Fund DES”E

b
o Up 988 Rows  » | Down v el [0 10001998 of 3455

+Fizcal »Budget »Account »Budget mBudget weAcct  Acct »Date »d P Source L
Year Petiod Type Category  Category Desct
Descr

| | | | H

ooe | 2610 |Car Repair 14NOV2106 (00257480 Floel & The screen refreshes and displays next set of data.
Center

00E 2410 Car Repair  14-NOV-2008 00257430 Fleet 3
Center

O0E 2410 Car Repair 14-NOV-2008 00257479 Fleet 5
Center

O0E 2410 Car Repair  14-NOV-2008 00257479 Fleet 5

KUMC data
]

z_‘,'warEhOUS 3. Click as desired.

Connuel > Warkbaoks > PeoplSoll Faancials Wirkbaok - Detad Ripa Connected to PeapleSaft Financials Data .
PaapleSoft Financlals Warkbaok - Datall Reapart TO C||Ck GO tO Step
&1 rur Monday, April 21. 2008 01:15:59 PM CDT

IRl Query another | g0 o)1t narameters

Parameters SpeedType or : 1 on page 10
1o s e T Ve Department (»] expand if needed)
Expon « Fiscal Year

S8 arnail

Workshesl oplons

Distuion P View a Summary | Summary Report link in
e Report the Worksheets menu

Dedail By pml Depit it 11

1onpage7

Exit the Data Logout link in the upper
Warehouse right corner of the page

Speedbymn

Stan Date

End Date
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EXPORT DATA

Export Data

M PeopleSoft Financials

Rerun query Data refreshed 26.NOV.07 8:00am
Save » Parameters

Save as

Eevert to saved vTable

o || Printable page »Tools Layout Format Stoplight Sort Rows and Columns

Erm [ B ——T | A . With desired data displayed, click Export link in the Actions

a Speedtype
Worksheet options Page ltems SREECE

Speedtype Descr | PeopleSoft Admin Support v | Dept Descr | PeopleSoft Admin Support v| Fund Descr ‘ Operatin menu.

mFiscal »Budget »-Account »Budget m-Budget »Acct »Acct »Date wld wSource  mendor

Detail Report* Year Perind Type Category Category Descr 1 1
ST B Descr The Choose export type page is displayed.
[ [—] | 1 1 I | |
2008 2008 E 1005 S&w 1006 S aw 01-JUL-2007 0000433167

1

2 2008 2008 E 1745 Fringes 1745  Fringes 01-JUL-2007 0000433168

KUMCdata gaee
warehouse mmms
O Preferences Logout Help

Connect > YWorkbooks > PeonleSoft Financials Workbook- Detail Report = Export Connected to PeopleSoft Financials Data : From the drop-down IISt’ Choose MlcrOSOft EXCQl

Choose expaort type *
Use the drop-down list to specify the export file format. el |l e WorkbOOk ( -XIS)-

[V (Comma delimited) (".csv) v C—

Cancel |  Export

Connect > Workhooks > PeopleSoft Financials Workbook - Detail Report > Export Connected to PeopleSoft Financials Data
Choose export type

Use the drop-down list to specify the export file farmat. Cance| Export . CI'Ck E}{ F' 0 rt
‘Mmmsnﬁ Excel Workhook (*.xls) v

The Export Ready page is displayed.

Connect = Workbooks > PeopleSoft Financials Workbook - Detail Report = Export
Export Ready

The export you requested is ready. Please click the button below to open the exported document to view or save it.

Click to view or save

Click to view or save |

r |

File Download X 5. Click as desired.

Do you want to open or save this file? To ... Go to Step...

View the report in a web

@ j Mame; Detail Report,xls version of Excel 6
[Hl Twpe: Microsoft Excel Worksheet

From:  dw.kume.edu Save the report as an
Excel file

Open ] [ Save ] | Carcel

Cancel the export
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EXPORT DATA

Export Data (continued)

Security Warning @

"http: ffdwe . kume, edu: 7777 Idiscoverer fexportiDet il 20Report. xls" contains
macros,

Macros may contain viruses, It is usually safe to disable macros, but if the
macros are legitimate, you might lose some Functionality,

[ Disable Macros i [ Enable Macros ] [ More Info

6. Click Enable Macros

File Edit Wiew Insert Format Tools Data GoTo  Favorites  Help

Al - # PeopleSoft Financials Data refreshed 26-MOV-07 8:00am

Ee | http:fdw.kumc.edu: 777 Hdiscovererfexport/Detail’%20Report.xls - Microsoft Internet Explorer

EEX

A | B8 T ¢ T o [ E [T F [ &

The report is displayed in a browser window using a web version

PeopleSoft Financials Pata refreshed 26-MOY-07 8:00am

Speedtype: APPEDZ01 [Dept:BO2| Fund |Speedtyp| Dept Fund

o Code:050 e Descr:Pe DescrOp
S| Descr:Pe | opleSoft | erating
opleSoft | Admin | Expendit
Admin | Support ures
Support

of Excel.
7. Click the File menu, then Save As to save the file.

8. Click to close the spreadsheet window. Go to step 18.

Fizcal Year Budget | Account | Budget | Budget
Period Type | Category | Category
Descr

Source

00g E 1005 S aW 01-Jul-2007

000433167

=

Save As

Save jm |@DataWarEhause Reports V| G ‘D’ ) '

a5

e

tdy Recent
Documents

T_

Desktop

My Documents

My Computer

File name: |DEta|I Report xls

MyMNeobwork | Saveastye | Miciosoft Excel Workshest

A Save As dialog box is displayed.
9. Navigate to the target folder.
10. Modify the filename.

11. Click | =ave

Version 1.1
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EXPORT DATA

Export Data (continued)

b —_— .-‘
Download complete |'-_| |E|E|

. Do you see the download complete dialog box?

Download Complete If no, go to step 18.
If yes, go to step 13.

Saved:
Cietail Report, xds From dw, kumc.edu . Click as desired.

Downlaaded: 27.0KEin 1 sec To ... Click... Go to Step...
Download to: C\Docu, . \APPE0201 Detail Report. xls

Transfer rate:  27.0 KB/Sec VIEW the report [
[IiClose this dialog box when download completes in Excel

Open 15

View the folder
[ Open ] [DpenEolder] I Close ] in which the file [ pen Folder ]
was saved

# Step 12 Display of the download complete dialog box is controlled
by the Internet Explorer options setting “Notify when downloads
complete” on the Advanced tab.

Close the dialog

box Cloze

& Data Warehouse Reports
Fil= Edit ‘iew Favorites Tools Help

4 | O cearch [ Foders | (& 3 X 9 | @~ The target folder is opened in a My Computer window.

14. Double-click the filename to open the file in Excel.
Address |23 C\Documents and Settings)lschroederiy Documents\Data Warehouse Reports

E—;d APPE0Z01 Detail Report.xls

Security Warning fgl

“C:\Documents and SettingstschroederifMy DocumentsiData Warehouse
Reports\APPEDZ0] Detail Repart,xls" contains macros,

Excel is launched and the macro security warning displays.

Macros may contain viruses, It is usually safe to disable macros, but if the 15 C||Ck EI'IEI'ZIlE Macraos ] .
macros are legitimate, vou might lose some Functionality,

[ Disable Macros | [ Enable Macros ] [ More Info
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EXPORT DATA

Export Data (continued)

B3 Microsoft Excel - APP60201 Detail Report.xls

El] File Edit View Insert Format Tools Data Window Help  Adobe POF
NG H R SR VE %R S - A lG s -ef
{ arial s - B 7 U === /0] % o @28 - G- A

Al - f% PeopleSoft Financials Data refreshed 26-NO%-07 5:00am
A B c D E F G H . . .
| | | | | | | The report is displayed in Excel.

PeopleSoft Financials Data refreshed 26-NOW-07 5:00am

Speedtype. APPBOZ01 |Deptb02| Fund |Speedtyp| Dept | Fund 16. Use Excel's formatting, sorting and filtering tools to modify
01 Code:050 2 Descr:Pe|Descr:Op the report as needed

3l Descr:Pe| opleSoft | erating '
opleSoft | Admin | Expendit :
Adrin | Sugport | ures 17. Close Excel and return to the Data Warehouse window.
Support

Fiscal Year Budget | Account | Budgst | Budget
Period Type | Category | Category
Descr
005 1005 5 01-Jul-2007  |0000433167

Connect > Workbooks > PeopleSofi Financials YWorkbook - Detail Report = Export

Export Ready

The export you requested is ready. Please click the button below to open the exporte . . .
port ¥ A y g g 18. When export is complete, click Return to worksheet link to

continue using the Data Warehouse.

Click to view or save

Eeturn to worksheet <—
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PRINT SUMMARY REPORT

Print Summary Report

M PeopleSoft Finan
Rerun query Data refreshed 26 -NOV.

Save » Parameters
Save as

Revert to saved vTable

Frintable page bTools Layout Format Stoplight Sort Bows and Colurmns

Export
Speedtype Key | APPEO201 v

Send as email ; e 3
Warksheet options Page ltems 2008
Fund Code |0503 v Speedtype Descr | PeopleSoft Admin Support ¥

Fund Descr | Operating Expenditures v

wBudget Period »Account Type »=Budget Category »Budget Category Descr »-Budget /Reve
0] ] | | |

Detail Report
Summary Repart

1 2008 E 1005 SEW $225 359

Printable Page Options

Set the options to generate a printable Portable Document Format (POF) document of your worksheet.

Content  Page Setup

General Options
Page iterns (3 Print current selection of page items
i . . No effect
O Print all combinations of page items,

Show page items (3 On the first page 0
O Never

Show title & On the first page 0
O Mever

Data (& Print all rows and colurmns
© Print only the rows and colufiNQ,Eff€Ct _ iayed in the crasstab or table.

[#] Print Header}
No effect
[#]Print Footer

1. With summary report data displayed, click the
Printable page link in the Actions menu.

The Printable Page Options page is displayed, with a focus
on the Content.

This page allows you to select the items to print.

Below is a sample of the report data which is affected by the
options choices at the left.

PaopleSoft Financiale
e Data refroshed 27 HOVOT 8:00am
» Parameters

»Table
{ Eomat ._,uL J| Saor '*'--"',ldl olutring

Spevdtrpn Ker APPRIZ01 Deptid
Speedtype Descr | PeapleSoft Admin Suppont » | Dept Descr | PeopleSoft Admin Suppont »

Page Hem Filnll\'nr 2000 v
0 Fund Code 0503

Fund Descr | Opeeating Expenditures »

+Budgot Period +Account Type & Budget Calegary »Budget Catoqory Doscr +Budgel Reenu = Expinddie Encumbrance - Balance

SawW $220 360 00 774874 $150 51026
Fringes §/2828563 §2353e8 $49 299 95
OOE $6.550,00 31997 $0.00 §254003

Sum; §307 748,63 Sum: $105.208.39 Sum: $0.00 Sum: $202,540.24

Table Options
[¥] Print table
[“IRepeat header cells on every page

Graph Options
MIPrint graph <«ue—
Frint gradients
Graph size & Actual size
O Specified size uu—
Width | |
Mzcimurm wicth: 9.95 (Inches)
Height | |
Mazximumn beight: 5 (Inches) 1

Content  Page Setup

Do you want to print the graph?

If no, uncheck Print graph check box and go to step 6.
If yes, go to step 3.

Click Specified size radio button

Enter 9 as the Width.

Enter 4 as the Height.

Click Page Setup link.
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PRINT SUMMARY REPORT

Print Summary Report (continued)

Printable Page Options
Set the options to generate a printable Portable Document Farmat (PDF) document of your worksheet Cancel ‘ Preview sample Printable PDF

Content Page Setup

Paper Setup
Size | Letter (11 x8.5) b
Orientation O Portrait @ Landscape

Margins

Inches

[ Inches

Inches Inches

Secaling
Set the scale of the printed workeheet

Scale |100% v

Column Sizes
Set the width of the printed columns.

Budget Period Account Type Budget Category Budget Category Descr Budget /Revenue Expenditure Encumbrance Balance
Column size (Inches) 104 | [11 | ftas 1 ] [tez | e [ f12s ] hza ]

# Step 8 For the Summary Report, there is no difference in output
between Preview sample and Printable PDF. The advantage of
using Preview sample is the ability to easily return to the Print
options page to make any needed modifications.

Connect = Workbooks > PeopleSoft Financials Workbook - Summary Report > Printable Page Options
PDF Sample Ready

A sample PDF has been generated using the options selected. After verifying that the sample is correct,
generate a complete PDF document.

@ Open POF to view sarmple

Print options

7. Page Setup should default correctly.

Orientation is set to Landscape.
Margins are set to:

Top: 0.5 Bottom: 0.5

Left: 0.25  Right: 0.25

8. Click Freview sample

9. Click Open PDF to view sample link.
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PRINT SUMMARY REPORT

Print Summary Report (continued)

File Edit GoTo Favorites Help

=l & (1]

Faopisfol Fimnsisis
Dntn ratramhied ZTACY-2T E:00am

Fisca Faur 2008 | Szeaiype Ky APPSE | Doprd SE01 | Fund Cote G500 | Spanchys Seser ecplation Admin Suspon | Depe Dusce: Proplsiist Asran
Suppart | Fared e Coerating Expansisns

e i I Baeeen
i o E s

e E )
e e O0E

]
0

. Do the print options need to be modified?

If no, go to step 11.

If yes, to close the preview window and go to step 14.

. Click [EF to print the report.

. Click to close the preview window.
. Go to step 15.

&] Done Unknown Zone

@ Open POF to view sarmple

Connect = Waorkbooks > PeopleSoft Financials Workhook - Summary Repart > Printable Page Options . Click Print options link on in the PDF Samp|e Ready page
PDF Sample Ready _ _ . _ and return to step 2 to modify the graph or step 6 to modify
A gample POF has been generated using the optighs selected. After verifying that the sample is correct, the marains
generate a complete PDF document. g '

. When printing is complete, click PeopleSoft Financials
Workbook-Summary Report link at the top of the PDF

Print options «ee—

Sample Ready page.

NOTE: Print options and page setup choices are retained only
as long as you stay within the report. Settings are lost when
changing to the Detail Report or when you Logout of the Data
Warehouse.
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PRINT DETAIL REPORT

Print Detail Report

M PeopleSoft Financials

Betun query Data refreshed 27-NOVOT 8:00am
Save »Parameters

Save as

Revert to saved vTable

Brintable page »Tools Layout Format Stoplight Sort Rows and Colurmns

Export

Send as email ; Speedtipe Dept Fund Gode -
Warkehael nplions Page ltems =P ¥R APPEO201 v 4 BO201 v 0503
S —— Speedtype Descr |PeopleSoft Admin Support v Dept Desct | PaopleSoft Admin Support v Fund Deser | Operating
m mFiscal wBudget »Account =Budget m-Budget »Acct »=Acct »Date wld »Source  eYendor
Detail Report Year  Period Type  Category Category Descr
Summary Report Descr

i | I | S S I I
2008 2008 1005 SaWw 1008 S &W 01-JUL-2007 0000433167

1

Printable Page Options

Set the options to generate a printable Portable Document Format (POF) document of your worksheet.

Content  Page Setu) <uu—

General Options
Page iterns (3 Print current selection of page items
i . . No effect
O Print all combinations of page items,

Show page items (3 On the first page 0
O Never

Show title & On the first page 0
O Mever

Data (& Print all rows and colurmns
© Print only the rows and colufiNQ,EffE€Ct _ layed in the crasstab or table.

With detail report data displayed, click the
Printable page link in the Actions menu.

The Printable Page Options page is displayed, with a focus
on the Content.

This page allows you to select the items to print.

Below is a sample of the report data which is affected by the
options choices at the left.

[#] Print Header}
No effect
[#]Print Footer

9 PeopleSoft Financials
Data refreshed 27-NOVO7 8:00am
» Parameters

Table
FTools Layout Forrmat Stoplight Sort Rows and Columns

mj“em Speediype APPBO201 Dept  |go201 ~ Fund Code |p503 v

Speediype Descr PeopleSoft Admin Support ¥ Dept Descr | PeopleSoft Admin Support ¥ Fund Descr ‘ Operating Expenditures v

wFiscal »Budget »Account »Budget Budget »Acct »Acct » Date > Id »Source  mYendor - Descriptor
Year Period Type Category Category Descr
Deser
o—— | | IS | S| | I

2008 2008 S&w 1005 S &w D1-JUL-2007 0000433167 KU Budget
Opening Entries

2008 2008 Fringes 1745  Fringes 01-JUL-2007 0000433168 KU Budget
Opening Entrigs

2008 2008 00E 2000 OOE  O1-JUL-2007 0000431926 KU Budget

2

3

Opening Entries

2. Click Page Setup link.
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PRINT DETAIL REPORT

Print Detail Report (continued)

Printable Page Options
Set the optiong to generate a printable Portable Document Format (FDF) document of your worksheet. Cancel | Preview sample Printable PDF

Content Page Setup
Paper Setup
Size | Letter (11 x B.5) v
Orientation O Portrait & Landscape
Margins

Inchies

I Inches

Inches Inches

Scaling
Set the scale of the printed worksheet

Scale

Step 4 For the Detail Report, there is a difference in between
Preview sample and Printable PDF. Preview sample generates a
worksheet based on the first 50 rows of data. The advantage of
using Preview sample is the ability to easily return to the Print
options page to make any needed modifications.

Connect = Workbooks > PeopleSoft Financials Warkbook- Detail Report = Printable Page Options
PDF Sample Ready

A sample PDF has been generated using the options selected. After verifying that the sample is corr
generate a complete POF document.

@ Dpen PDF to view sample

Erint options

1
Fle Edt Gofo Favorbes Heb

=5 68 &-

Page Setup should default correctly.
Orientation is set to Landscape.
Margins are set to:

Top: 0.5 Bottom: 0.5

Left: 0.25 Right: 0.25

Scale is set to 60%.

Click Freview sample

Click Open PDF to view sample link.

6. Click to close the preview window.
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PRINT DETAIL REPORT

Print Detail Report (continued)

Do the print options need to be modified?

Connect > Workbooks > PeopleSoft Finaneials Workhook - Detail Report > Printable Page Options Connected to PeopleSoft Financials Data
PDF Sample Ready

A sample PDF has been generated using the options selected. After verifying that the sample is carrect, click the "Printable PDF* buttan to Printable PDF If n O il go to Step 8-
generate a complete PDF document. —
g [T — If yes, click Print options link on in the PDF Sample

Ready page and return to step 3.

Print options h Printable PDF

Click Erintable PDF

Connect > Workbooks > PeopleSoft Financials Workbook- Detail Repot = Printable Page Options
PDF Ready

The complete PDF document has been generated. Please click the link below to view or save it.

_ _ . Click Click to view or save link.
@ Click to view or save

Eeturn to worksheet

A hitp:Hdw.kumc.edu: 77T idiscoverer/print/Detail’%20Report. pdf - Microsoft Internet E... [ ][B][%)

Fle Edt GoTo Favorites Help

10. Click [Ep to print the report.

11. Click to close the preview window.

Unknovwn Zone

Connect > Warkbooks > PeopleSoft Financials WWorkbook- Defail Report = Printable Page Options . .
PDF Ready 12. Click Return to worksheet link.

The complete PDF document has been generated. Please click the link below to view or save it. NOTE: Print options and page setup choices are retained only

@ Click to view or save as long as you stay within the report. Settings are lost when
changing to the Summary Report or when you Logout of the
Return to worksheet Data Warehouse.
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VIEW MULTIPLE SPEEDTYPES

The Parameters portion of the detail report allows the user to query the data by distribution code, a single department, multiple departments, a
single SpeedType or multiple SpeedTypes. When querying by distribution code or department, data for multiple SpeedTypes could be returned at
one time. Viewing and exporting data sets for multiple SpeedTypes is different from viewing and exporting data for a single SpeedType.

View Multiple SpeedTypes

rParameters

Select values for the following parargters. 1. Enter Fiscal Year and Distribution Code in the related

* |nclicates required figld Param eters fl e Ids
* Fiscal Year ‘ZEIEIE' ‘ xf .
Example: 2008, 2007 OR

Dlstnbéhsn ‘ #
[—— ' Enter Fiscal Year and Department ID in the related

Department D [B0101" | Parameters fields.

Example: BO201, 04030

Speedtype ‘ ‘ # OR

Example: appB0201, RFFO4030

Start Date | | Enter Fiscal Year and SpeedTypes separated by commas

(Exemple: 21-47R-200%) in the related Parameters fields.
End Date ‘ ‘ #

(Example: 21-APR-2008) G
[u]

6l 2. Click

Query Progress

@ Executing query

Estimated Time Unknown A Query Progress page will display while data is retrieved.
Elapsed Time 0o:00:01

Cancel | Refresh

Collapse button
Selec it s fllcrwing pasamatess.

= Frgcal Your |2008°

Distribution
Code

Jepartment D W01

Optional: Once the query results are displayed, click |E|
(collapse) next to Parameters to view more data on the screen.

Spendtypo
i
Stant Date

End Date

60101 &
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VIEW MULTIPLE SPEEDTYPES

View Multiple SpeedTypes (continued)

k= Parameters

*Table

Tools Lavout Format Stoplisht Sot Bows and Columns All SpeedTypes requested are retrieved. Transaction lines for

the first SpeedType (in alpha/numeric order) are displayed in the

Page ltems Speedtype APPEOIO1 ~|  Dept  [B0101 + table.

. Speedtype Descr [amse s Dept Descr | Accounting

o _ RONVEDT01 3. CIicknexttotheSpeedTypetodispIaythe list of

»Fiscal »Budget w=HABUTO dget »Budget Acct SpeedTypes.

Year  Period <All= gory  Category
Descr

4. Click SpeedType to display.
J

2005 2008 E 1005 SR 1005

PeopleSoft Financials
Data refreshed 27-NOV-07 8:00am
»Parameters

*Table
»Tools Layout Format Stoplight Sont Rows and Columns

Page ltems Speediype ROWEDTO] v Dept  |B01071 |+ Fund Code |2a00

Speedtype Desct | Accounting Controller v Dept Descr ‘Accnummg Controller | Fund Descr ‘ Sponsored Research Overhead v

»Fiscal »Budget »Account wBudget »Budget »Acct e Acct »Date »d #Source  Vendor  wDescriptor =Bu . . - .
: oy Catego ’ The screen is refreshed, and displays transaction lines from

Year Period Type  Category Category Descr

o e —— . — : = selected SpeedType.

2008 2008 E 1005 SA&W 1005 S &WY 01-JUL-2007 0000432497 KU Budget
Opening
Entries

2008 2008 E 1745 Fringes 1745 Fringes 01-JUL-2007 0000432498 KU Budget

Opening
Entries

2008 2008 E 2000 00E 2000 OOE  01-JUL-2007 0000433071 KU Budget
3 Opening
Entries
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EXPORT MULTIPLE SPEEDTYPES

Only currently viewed data can be exported. In order to export all SpeedTypes at once, the SpeedType field must be moved from the Page Items
area into the table grid.

Export Multiple SpeedTypes

|
“Table W

»Tools Layout Format Stoplight Sort Rows and Columns

Page hems Speediype APPEOIOT % Dept G010 Fund Code |05p3 1. Click Layout on the Tools menu
I Speedtype Descr Dept Descr | Accourting Cortroller v | Fund Descr | perating Expenditures v

I
mFiscal »=Budget »-Account »Budget wBudget =Acct wAcct b Date »1d b Source e
Year Period Type Category  Category Descr

Desor The screen is refreshed and the Layout tools appear.
= | | | |1 | | |

2008 2008 1005 Saw 1mos 3 &awy 01-JUL-2007 0000433311

2008 2008 1745 Fringes 1745 Fringes 01-JUL-2007 0000433312

*Table
rlools Layout Format Stoplight SEd Rows and Columns

rage Items Speedtype APPEO101 Dept 60101+ Fund Code | 0503 |«
Speedtype DESCV Dept Deser | Accounting Cortraller » | Fund Descr | operating Expenditures

kFiscal #Budget »Account »Budget e Budget =Acct wAcct ¥ Date »1d b Source e 2 CIICk for the fleld IlSt-
Year Period Type Category  Category Descr

Descr
0] | | — | | |

2008 2008 Saw 1mos 3 &awy 01-JUL-2007 0000433311

2008 2008 Fringes 1745 Fringes 01-JUL-2007 0000433312
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EXPORT MULTIPLE SPEEDTYPES

Export Multiple SpeedTypes (continued)

rTable
*Tools Layout Format Stoplight Sort Rows and Columns

fage Htems Budgst Period D1 v|  Dept 3. Click SpeedType in the list of fields.

Account Type
Budget Category r v Dept Descr |Accounting Cantraller V|
Budget Category Descr
B | Acct B Budget  wBudget MAcct »Acct i

Acct Descr Category  Category Descr . Go
Date Descr 4. Click =

Id

Source =AU 1006 S&WwW 01-J
“endar

Descriptor
0 Budgetpmevenue Fringes 1745  Fringes 01-J

Expenditure

Encumbrance O0E 2000 OOE 01
Balance

= dt —
Dept Fon & Mwk 2005  Fon & 01-J

Ttk
Fund Code
Shesdifpe Descr COE 2630 OpChy 05 The screen is refreshed with the SpeedType field displayed as the
P Dosnr first column in the table. The data displayed is still limited to the
o oo D0E 2631 CpChg 05-J first SpeedType.

The position choice box changes to “Left of Fiscal Year”.

*Table
*Tools Layout Format Stoplight Sod Rows and Columns

Click | ¥ | next to Fund Code.
Click <All>.

rngje ltems Dept o] el | ezl Dlosey 7 ClICk next to Fund DeSCI’
Dept Descr | Accounting Controller v | Fund DESEr | Cperating Expenditures v |«

»Speedtype m-Fiscal »Budget mAccount »-Budget mBudget mAcct wAcct b Date 8 C“Ck <A”>-
Year Period Type Category  Categary Descr
Descr

5.
6.

9. Click next to Speedtype Descr.
10. Click <All>.

The screen refreshes after each drop-down choice is made.
APPEDI0T 2008|2008 OvE 200 |0OE |01-JUL-2007 | DN00431513 The resulting list of data displays the transaction lines in date
order. Once the data is exported to Excel, it can be sorted by
SpeedType.

APPBO1OT 2008 2008 5 AW 1008 5 & 01-JUL-2007 0000433311

APPEO101 2008 2008 Fringes 1745 Fringes 01-JUL-2007 0000433312

11. Click Export link in the Actions menu.

12. Go to step 2 on page 13 (Export data).
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SAVE WORKBOOK

Once you have modified the layout of a report, you might want to save it as a separate workbook.
Save Workbook

Berun guery

Save » Parameters
Save as

Reverttosaveg ~ vTable

Printable page #Tools Layout Format Stoplight Sort Rows and Colurmns
Export

Send as ernail § Dent Fund Code . Click Save as in the Actions menu.
Warkshast antions Page ltems P 60101 »
—_— Dept Descr | Accounting Contraller v | Fund Descr | =All=

b Speedtype BFiccal kBudget »Account B-Budget BBudget MAcct bAcct »
Detail Report™ ‘ear Period Type Category  Category Descr
Surmary Report Descr
= | | | | | |
RCWED101 2008 2008 1005 SaW 1005 S&Ww 01-J

The Save Workbook As page is displayed.

Conneet > Workhooks > PeopleSoft Financials Workbook - Detal Report
Save Workbook As

Chooge a new nare for this workbook Cancel Apply . Enter WOFkbOOk Nam e.
* Indicates required field

= Waorkbook Name | Multi Speedtype Workbaok C— . -"'J'\Eplh"
TIP The workbook will be saved in the root of the folder tree ) CIICk

Connected to PeopleSoft Financials Data

Connect = Workbooks > Multi Speedtype Workbook - Detail Report

Information

The workbook was saved successfully J

Multi Speedtype Workbook - Detail Report
Last run Wednesday, November 28, 2007 02:23:56 PM CDT

The report page displays with the Information message
displayed at the top.

rParameters

Select values for the following parameters.
* |noicates required field

= Figcal Year 2003 | N?

Revert to saved
Printable page

Worksheet List

Search
Type in & search string to find a specific workbook or result set. Use the drop-down menu

Search|AHWorkhooks V‘ | | E

The next time you connect to PeopleSoft Financials Data, the

Result List new workbook appears in the list.
Refresh |

Expand All | Collapse All
“Digcaverer YWarkhooks

To delete a workbook, contact PeopleSoft Support at 8-1121.

Focus Name Description|
+ Discoverer Workbooks

X > 2 MUl Speedtype Workbook

X » @Penp\eSnﬂ Financials ¥Waorkhook
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APPENDIX

Assistance

Questions regarding how to utilize the PeopleSoft Financials Workbooks in the Data Warehouse, how to navigate, and other
technical or procedural problems with the system should be directed to PeopleSoft Support at ext 8-1121.

The office is usually staffed from 8:00 AM to 4:30 PM. In the event no one is available to assist, you may leave your question on the
office Audix voice mail system, and we will return your call.
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